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Practical-01 Browser Feature, browsing, using various search 
engines, writing search queries. 

Browser Feature: 
The most popular browsers have a number of features in 
common. They allow users to set bookmarks and browse in 
a private mode. They also can be customized with extensions, 
and some of them provide a sync service. 
Most browsers have these user interface (UI) features: 

 Allow the user to open multiple pages at the same time, 
either in different browser windows or in different tabs of 
the same window. 

 Back and forward buttons to go back to the previous page 
visited or forward to the next one. 

 A refresh or reload and a stop button to reload and cancel 
loading the current page. (In most browsers, the stop button 
is merged with the reload button.) 

 A home button to return to the user's home page. 
 An address bar to input the URL of a page and display it. 
 A search bar to input terms into a search engine. (In some 

browsers, the search bar is merged with the address bar.) 
 

Browsing using various search engines: 
A search engine is a web-based tool that enables users to locate 
information on the World Wide Web. Some popular examples of search 
engines are Google, Yahoo!, and MSN Search, etc. 
 
 

@
Dipl

om
a_

Stud
y_

Roo
m



Steps to use a search engine are: 

 Vary your search engine: in fact, get used to using several, as they 
have different strengths. 

 Use specific keywords: be as specific as you can in your wording. 
 Simplify your search terms: strip out unnecessary stop words and 

avoid suffixes. 
 Use quotation marks: this narrows searches down to particular 

words and phrases. 
 Remove unhelpful words: remove confusing or misdirecting 

terms from your searches with the - (minus) operator. 
 Refine your search using operators: use operators to search 

specific sites, related sites, and particular combinations of terms. 
 Avoid search pitfalls: the internet is a selling tool as well as a 

fantastic resource. Be sure that you only view advertisements if 
you want to. 

Writing search queries 
A search query is a string of text that someone types into a search 
engine, using various combinations of keywords, in order to receive a 
list of results (called a SERP) with various information that is intended 
to help provide them answers. 

There are mainly three types of search queries: 

1. Navigational Search Query: A navigational search query is a 
search query entered with the intent of finding a particular 
website or webpage. For example, a user might enter "YouTube" 
into Google's search bar to find the YouTube site rather than 
entering the URL into a browser's navigation bar or using a 
bookmark. In fact, “face book” and “YouTube” are the top two 
searches on Google, and these are both navigational queries. 
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2. Informational Search Query: Queries that cover a broad topic 
(e.g., Colorado or trucks) for which there may be thousands of 
relevant results.” When someone enters an informational search 
query into Google or another search engine, they’re looking for 
information – hence the name. They are probably not looking for 
a specific site, as in a navigational query, and they are not looking 
to make a commercial transaction. They just want to answer a 
question or learn how to do something. 

3. Transactional Search Query: A transactional search query is a 
query that indicates an intent to complete a transaction, such as 
making a purchase. Transactional search queries may include 
exact brand and product names (like “Samsung galaxy s3”) or be 
generic (like “iced coffee maker”) or actually include terms like 
“buy,” “purchase,” or “order.” 
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Practical-2 Visit various e-governance/digital India portals, 
understand their features, services offered. 

 Digital India: Digital India is a campaign launched by 
the Government of India in order to ensure the 
Government's services are made available to citizens 
electronically by improved online infrastructure and by 
increasing Internet connectivity or making the country 
digitally empowered in the field of technology.[1][2] The 
initiative includes plans to connect rural areas with high-
speed internet networks. It consists of three core 
components: the development of secure and stable digital 
infrastructure, delivering government services digitally, 
and universal digital literacy. 

 Mygov.in:  It is a citizen engagement platform[2] founded 
by the Government of India to promote the active 
participation of Indian citizens in their country's 
governance and development.[3] It is aimed at creating a 
common platform for Indian citizens to "crowd 
source governance ideas from citizens".[4] Its users discuss 
and contribute to various government projects and 
plans.[5] It also allows users to upload documents in 
various formats. The website is hosted and managed by 
the National Informatics Centre (NIC).[6] Prime 
Minister Narendra Modi stated that the aim was to reduce 
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the long gap developed between the electorate and 
the Executive after being elected. 

 National Scholarship Portal: National Scholarship 
Portal (NSP) is a digital scholarship platform that carries 
multiple scholarships offered by the central government, 
state governments and different government agencies like 
UGC (University Grants Commission). The National 
Scholarship Portal hosts about 50 scholarships worth 
hundreds of crores for the scholarship seekers registered 
on the platform.  According to officials, the platform has, 
so far, helped the government implement and disburse 
scholarships worth more than INR 2,400 crores. The 
platform boasts of more than 110 Lakh applications out of 
which over 85 Lakh applications are verified also. 

Introduced as the Mission Mode Project under the 
National e-Governance Plan (NeGP), the National Scholarship 
Portal emerges as one of the most prominent scholarship 
portals that offer a variety of services ranging from student 
scholarship application to the disbursal of scholarships to 
them. Offering a SMART (Simplified, Mission-oriented, 
Accountable, Responsive & Transparent) system for effective 
and faster disposal of scholarships, the portal ensures direct 
delivery of funds to the beneficiary’s account thereby 
avoiding any chances of leakage. 
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Practical-3 

Read Wikipedia pages on computer hardware 
components, look at those components in lab, 
identify then, recognize various ports/interfaces and 
related cables,etc. 

Computer hardware includes the physical parts of a computer, such 
as the case,[1] central processing 
unit (CPU), monitor, mouse, keyboard, computer data 
storage, graphics card, sound card, speakers and motherboard.[2] 

By contrast, software is the set of instructions that can be stored and 
run by hardware. Hardware is so-termed because it is "hard" or rigid 
with respect to changes, whereas software is "soft" because it is easy 
to change. 

Hardware is typically directed by the software to execute any 
command or instruction. A combination of hardware and software 
forms a usable computing system, although other systems exist with 
only hardware. 

Components of computer hardware: 

Input Devices  
Input devices comprise of any devices that users need in order to give 
instructions to a computer. Essentially input devices act as the medium 
for sending data to a computer so that users can interact with and 
control it. The most widely known examples are the keyboard and 
mouse. Input devices are also used to transfer data between 
computers.  
Following are some of the important input devices which are used in a 
computer − 

 Keyboard 
 Mouse 
 Joy Stick 
 Light pen 
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 Track Ball 
 Scanner 
 Graphic Tablet 
 Microphone 
 Magnetic Ink Card Reader(MICR) 
 Optical Character Reader(OCR) 
 Bar Code Reader 
 Optical Mark Reader(OMR) 
 

Output Devices  
Output devices are devices that allow computers to send data to other 
devices or to users. In general, the data that computers send to human 
users is in forms that we can understand. Most often, these forms 
include audio and video. The most widely known examples of output 
devices are monitors, speakers and printers. These devices produce 
video, audio and graphic output, respectively.  

Following are some of the important output devices used in a 
computer. 

 Monitors 
 Graphic Plotter 
 Printer 

 

Processing Devices  
Processing is the core function of any computer. When a computer 
receives data from an input device, this data must first go through an 
intermediate stage before it is sent to an output device. Processing is 
the intermediate stage where raw data is transformed into information 
so that it can be outputted meaningfully for the user. An example of a 
processing device is the central processing unit (CPU), which is a set of 
electronic circuitry that processes and executes instructions.  
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Memory (Storage) Devices 
Memory devices are any devices that are capable of storing information 
temporarily or permanently. There are two types of memory; primary 
and secondary. Primary memory refers to RAM (random access 
memory), which is used to store instructions and data temporarily 
before and after they are processed. RAM is volatile, which simply 
means it only retains information when the computer is turned on and 
is cleared once the computer turns off.  
Secondary memory refers to any external storage media. Secondary 
memory is non-volatile, which means that information can be stored 
long-term. The most common example of an external secondary 
memory device is the USB flash drive. 
 
 Digital Data Storage Devices for Computers 

 Hard Drive Disks. 
 Floppy Disks. 
 Tapes. 
 Compact Discs (CDs) 
 DVD and Blu-ray Discs. 
 USB Flash Drives. 
 Secure Digital Cards (SD Card)s. 
 Solid-State Drives (SSDs) 
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Practical-4 Install Linux and Windows operating system on 
identified lab machine, explore various options, do 
it multipal times. 

Linux is an open source and free operating system to install which 
allows anyone with programming knowledge to modify and create its 
own operating system as per their requirements. Over many years, it 
has become more user-friendly and supports a lot of features such as 

1. Reliable when used with servers 
2. No need of antivirus 
3. A Linux server can run nonstop with the boot for many years. 

It has many distributions such as Ubuntu, Fedora, Redhat, Debian but 
all run on top of Linux server itself. Installation of every distribution is 
similar, thus we are explaining Ubuntu here. 
So let’s get started using this wonderful operating system by any of the 
following methods. 
A. Install Linux Using CD-ROM or USB Stick 
Download .iso or the ISO files on a computer from the internet and 
store it in the CD-ROM or USB stick after making it bootable using Pen 
Drive Linux and UNetBootin 

1. Boot into the USB Stick 
You need to restart your computer after attaching CD –ROM or 
pen drive into the computer. Press enter at the time of boot, here 
select the CD-ROM or pen drive option to start the further boot 
process. Try for a manual boot setting by holding F12 key to start 
the boot process. This will allow you to select from various boot 
options before starting the system. All the options either it is USB 
or CD ROM or number of operating systems you will get a list 
from which you need to select one. 

Note:- 
You will see a new screen when your computer boots up called “GNU 
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GRUB”, a boot loader that handles installations for Linux. This screen 
will only appear in case there is more than one operating system. 

 

 Set the keyboard layout. 

 Now you will be asked What apps would you like to install to start 

with Linux? The two options are ‘Normal installation’ and 

‘Minimal installation’. 
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2. Derive Selection 
Select the drive for installation of OS to be completed. Select “Erase 

Disk and install Ubuntu” in case you want to replace the existing OS 

otherwise select “Something else” option and click INSTALL NOW. 

 

3. Start Installation 

 A small panel will ask for confirmation. Click Continue in case you 

don’t want to change any information provided. Select your 

location on the map and install Linux. 

 Provide the login details. 
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4. Complete the installation process 
After the installation is complete you will see a prompt to restart the 
computer. 
You are almost done. It should take 10-15 minutes to complete the 
installation. Once the installation finishes, restart the system.  
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Practical-5 Connect various peripheral (printer, scanner.etc) to 
computer ,explore various features of peripheral and 
their device driver software. 

Here are the general procedures to install any peripheral device: 

1. Read the manufacturer's directions. I know you don't want to hear 
that again, but when you follow these directions, the installation goes 
better. If you later have a problem with the installation and you ask the 
manufacturer for help, being able to say you followed the directions 
exactly as stated goes a long way toward getting more enthusiastic help 
and cooperation. 
 
2. Make sure the drivers provided with the device are written for the 
operating system (OS) you are using. 9 Recall that 64-bit drivers are 
required for a 64-bit operating system, and 32-bit drivers are required 
for a 32-bit OS. You can sometimes use drivers written for older 
Windows versions in newer Windows versions, but for best results, use 
drivers written for the OS installed. You can download the drivers you 
need from the manufacturer's website. 
 
3. Make sure the motherboard port you are using is enabled. Most 
likely it is enabled, but if the device is not recognized when you plug it 
in, go into UEFI/BIOS setup and make sure the port is enabled. In 
addition, UEFI/BIOS setup might offer the option to configure a USB 
port to use SuperSpeed (USB 3.0), Hi-Speed USB (USB 2.0), or original 
USB (USB 1.1). Figure 9-5 shows the BIOS setup screen for one system 
where you can enable or disable onboard devices. In addition, if you are 
having problems with a motherboard port, don't forget to update the 
motherboard drivers that control the port. 
 
4. Install drivers or plug in the device. Some devices, such as a USB 
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printer, require that you plug in the device before installing the drivers, 
and some devices require you to install the drivers before plugging in 
the device. For some devices, it doesn't matter which is installed first. 
Carefully read and follow the device documentation. For example, the 
documentation for one digital camera says that if you install the camera 
before installing the driver, the drivers will not install properly. If you 
plug in the device first, Device Setup launches and steps you through 
the installation of drivers (see Figure 9-6). As Device Setup works, an 
icon appears in the taskbar. To see the Device Setup box, as shown in 
the figure, click the icon. 
 
5. Install the application software to use the device. For example, a 
FireWire camcorder is likely to come bundled with video-editing 
software. Run the software to use the dev 
Plug a mouse or keyboard into a USB port and Windows should 
immediately recognize it and install generic drivers. Because PS/2 ports 
are not hot-pluggable, you must restart Windows after plugging a 
mouse or keyboard into a PS/2 port. 
For keyboards with special features such as the one shown in Figure 9-
7, you need to install the drivers that came with the keyboard before 
you can use these features. Also notice in Figure 9-7 a green USB to 
PS/2 adapter and a purple PS/2 to USB adapter, which can solve the 
problem when a case has PS/2 ports and doesn't have enough USB 
ports. 
You can later use Device Manager to uninstall, disable, or enable most 
devices. However, USB devices are managed differently. To uninstall a 
USB device such as the USB keyboard shown in Figure 9-7, use the 
Programs and Features window. 
To open the window in Windows 8, press Win+X and click Programs and 
Features. For Windows 7, click Start, click Control Panel, and click 
Programs and Features. In the Programs and Features window (see 
Figure 9-8), select the device and click Uninstall. Follow the directions 
on screen to uninstall the device. 
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Replacing the keyboard is pretty easy to do. Before you begin any 
disassembly of a laptop, refer to the manufacturer documentation. 
Here are typical steps that are similar to many models of laptops: 
1. Power down the laptop and remove the AC adapter and the battery 
pack. 
 
2. Remove two or more screws on the bottom of the laptop (see Figure 
9-9). (Only the manufacturer documentation can tell you which ones 
because there are probably several of them used to hold various 
components in place.) Figure 9-9 Remove screws on the bottom of the 
laptop 
 
3. Turn the laptop over and open the lid. Gently push the keyboard 
toward the lid while pulling it up to release it from the case (see Figure 
9-10). Figure 9-10 Pry up and lift the keyboard out of the laptop case 
 
4. Bring the keyboard out of the case and forward to expose the 
keyboard ribbon cable attached under- neath the board. Use a 
screwdriver to lift the cable connector up and out of its socket (see 
Figure 9-11). 
 
5. Replace the keyboard following the steps in reverse order. 
A barcode reader is used to scan barcodes on products at the point of 
sale (POS) or when taking inventory. 
The reader might use a wireless connection, a serial port, a USB port, or 
a keyboard port. If the reader uses a keyboard port, most likely it has a 
splitter (called a keyboard wedge) on it for the keyboard to use, and 
data read by the barcode reader is input into the system as though it 
were typed using the keyboard. Figure 9-12 shows a barcode reader by 
Intermec that is a laser scanner and uses Bluetooth to connect 
wirelessly to the computer 
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A biometric device is an input device that inputs biological data about a 
person, used to identify a person's fingerprint, handprint, face, voice, 
eye, or handwritten signature. 
For example, you can use a fingerprint reader to sign in to Windows or 
to access an iPhone using Touch ID technology. These fingerprint 
readers should not be considered the only authentication to control 
access to sensitive data: for that, use a strong password, which is a 
password that is not easy to guess. 
A digital camera or camcorder can hold images and videos both in 
embedded memory that cannot be removed or exchanged and in 
removable flash memory cards. 
Both of these types of memory retain data without a battery. 
Here are two ways to transfer images from your camera or camcorder 
to a computer: 
 
-- Connect the camera or camcorder to the computer using a cable. 
Using embedded memory or flash memory cards, you can connect the 
device to your computer using a USB or FireWire port and cable. To 
connect the device to the computer, you might need to first install the 
software and then connect the device, or you might need to connect 
the device and then install the software. Read the camera or cam- 
corder documentation to find out which order to use. After the device 
and software are installed, the software displays a menu to download 
images or video to your computer. 
 
-- Install the memory card in the computer. If images or video are 
stored on a flash memory card installed in your device, you can remove 
the card and then insert it in a flash memory card slot on your 
computer. Most laptop computers have one or more of these slots (see 
Figure 9-14). 
If your computer doesn't have this slot, or the slot is not compatible 
with the type of card you are using, you have two choices: 
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-- Perhaps you can purchase an adapter so that your smaller memory 
card will fit into a larger card slot. (Examples of these adapters. 
MicroSDHC USB adapter PRO Duo adapter MiniSD adapter memory 
card SD adapter) 
 
-- You can install a USB smart card reader that provides a memory card 
slot to fit your card. Figure 9-16 shows one reader that connects to a 
computer using a USB port. 
A webcam (web camera) is embedded in most laptops and can also be 
installed as a peripheral device using a USB port or some other port. For 
example, the webcam shown in Figure 9-17 works well for personal 
chat sessions and videoconferencing and has a built-in microphone. 
First, use the setup CD to install the software and then plug in the 
webcam to a USB port. A+ Exam Tip A+ 220-901 1.12 A webcam comes 
with a built-in microphone. You can use this microphone or use the 
microphone port on the computer. Most software allows you to select 
these input devices. 
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Practical-6 06 Practice HTML commands, try them with 
various values make your own Webpage. 

Learn HTML Using Notepad or 
TextEdit 
Web pages can be created and modified by using professional HTML 
editors. 

However, for learning HTML we recommend a simple text editor like 
Notepad (PC) or TextEdit (Mac). 

We believe in that using a simple text editor is a good way to learn 
HTML. 

Follow the steps below to create your first web page with Notepad 
or TextEdit. 

Step 1: Open Notepad (PC) 

Windows 8 or later: 

Open the Start Screen (the window symbol at the bottom left on 
your screen). Type Notepad. 

Windows 7 or earlier: 

Open Start > Programs > Accessories > Notepad 

Step 1: Open TextEdit (Mac) 
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Open Finder > Application

Also change some preferences to get the application to save files 
correctly. In Preferences > Format >

Then under "Open and Save", check the box that says "Display 
HTML files as HTML code instead of formatted text".

Then open a new document to place the code.

Step 2: Write Some HTML
Write or copy the following HTML code into Notepad:

<!DOCTYPE html> 
<html> 
<body> 
 
<h1>My First Heading</h1
 
<p>My first paragraph.
 
</body> 
</html> 

Finder > Applications > TextEdit 

Also change some preferences to get the application to save files 
Preferences > Format > choose "Plain Text"

Then under "Open and Save", check the box that says "Display 
HTML files as HTML code instead of formatted text". 

open a new document to place the code. 

Step 2: Write Some HTML 

Write or copy the following HTML code into Notepad: 

/h1> 

My first paragraph.</p> 

 

Also change some preferences to get the application to save files 
"Plain Text" 

Then under "Open and Save", check the box that says "Display 
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Step 3: Save the HTML Page 
Save the file on your computer. Select File > Save as in the 
Notepad menu. 

Name the file "index.htm" and set the encoding to UTF-8 (which 
is the preferred encoding for HTML files). 

 

Tip: You can use either .htm or .html as file extension. There is no 
difference, it is up to you. 

 

Step 4: View the HTML Page in Your 
Browser 
Open the saved HTML file in your favorite browser (double click on 
the file, or right-click - and choose "Open with"). 

The result will look much like this: 

These are most important features of OPEN OFFICE TOOLS. 
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Practical-7 Explore features of Open Office tools , create 
documents using these  features, do it 
multipale times. 

These are most important features of OPEN OFFICE TOOLS :- 

Productivity Enhancements 

New Custom Properties Handling 

 

OpenOffice.org allows users to define any number of custom document 
properties as name/value pairs in the File > Properties dialog. With version 3.3 
it is possible to also define DateTime values and values that contain a duration. 

Embedding of Standard PDF Fonts 
In previous versions, the standard PDF standard fonts (Times, Helvetica, 
Courier, Symbol and ZapfDingbats) were only embedded into the resulting PDF 
when the resulting file was of the PDF/A type, since the PDF/A standards 
requires this. In version 3.3, you can optionally embed these fonts in all PDF 
documents created by OpenOffice.org to enhance display accuracy in PDF 
viewers. 
New Narrow Font Family 
Oracle contributed a narrow font family to the free and open source Liberation 
font families. Being metrically compatible to the Arial Narrow font, widely used 
on Microsoft Windows systems, this font family now completes the Liberation 
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family and delivers a compatible and free set of fonts available on all 
platforms. 
 
 
 
 
 
 
 
Increased Document Protection in Writer and Calc 

 
OpenOffice.org Writer and Calc now allow two levels of document protection. 
As before, you can save a document with a password that prevents 
unauthorized users to read the content. Now you can also set a password to 
protect a document against unwanted changes. 
This way, you can make the content of a document available for reading to a 
selected group of people, and for reading and editing to a different group. This 
behaviour is now compatible with Microsoft Word and Excel file protection. 

Automatic Decimals Digits for "General" format in Calc 

In OpenOffice.org Calc, numbers formatted with the "General" number format 
will display as many decimal digits as required. In former versions, a maximum 
of 2 decimal digits were displayed with the "General" number format. 

One Million Rows in a Spreadsheet 
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OpenOffice.org Calc spreadsheets now support 1,048,576 (1 Million) rows 
instead of 65,536 rows. 

New Options for CSV (Comma Separated Value) Import in Calc 

 

Two new options are available when importing CSV files that contain data 
separated by specific characters. 

These options determine whether quoted data will always be imported as text, 
and whether OpenOffice.org Calc will automatically detect all number formats, 
including special number formats such as dates, time, and scientific notation. 
The detection depends on the language settings. 

Insert Drawing Objects in Charts 

 

The Chart functionality is enhanced and now supports drawing objects. The 
drawing toolbar allows to insert simple shapes such as lines, rectangles and 
text objects and even complex shapes such as cubes, symbols, block arrows, 
flowcharts and stars. The drawing objects can be edited by several dialogs 
which can be opened via the context menu. Also the font and formatting of 
text objects can be changed 

Hierarchical Axis Labels for Charts 
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If the categories in charts that get their data from spreadsheet span multiple 
rows and multiple columns, the direction of the first data series is detected. If 
the data for the first series comes from rows, the categories are split into 
multiple rows. Otherwise the categories are split into multiple columns. The 
split categories are then applied as different hierarchical labels at the x-axis. 

 

For charts with own data (typically used in Impress or Writer), there is a new 
icon to add text columns, which then will be used for the different levels in the 
x-axis labels. 

Improved Slide Layout Handling in Impress 

Handling of slide layouts in presentations is vastly 
improved. The content type of slide sections is now defined directly on the 
slide by clicking on one of the four content type icons: table, chart, picture, or 
movie, or entering text directly. 
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This reduces the number of slide layout varieties making the layout selection 
much clearer. In addition, you can now also assign layouts to slides and create 
new slides with a specific layout using the toolbar. One new toolbar element is 
used to add a new slide (or duplicate the currently selected slide). 
A similar toolbar element is used to assign a layout to the currently selected 
slide, or reset the layout to the assigned layout after making changes. 
 
Manual Setting for Primary Key Support for Databases 
When connecting to a database via an ODBC, JDBC, or ADO driver, Base used to 
apply a heuristic method to determine whether the database supports primary 
keys. In some cases, this heuristic method failed. Therefore, version 3.3 
introduces an explicit option to declare primary key support. When this setting 
is enabled, Base will always assume that the database supports primary keys, 
regardless of the result of the heuristic analysis. 
 
Support of Read-Only Database Registrations 
In OpenOffice.org, database registrations are stored in the application 
configuration files. Therefore, it is possible to deploy additional configuration 
fragments containing additional registrations. If those configuration fragments 
are declared as read-only (by using the usual configuration mechanisms for 
this), OpenOffice.org now blocks modifications (editions, removal) of the 
corresponding registration entry. 
 
New Math Command 'nospace' 
It will now be possible to explicitly remove the small horizontal space that 
always gets applied between two elements. 
 
Usability and Interface 
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Common Search Toolbar

 

Usage data indicated that a large portion of OpenOffice.org users want to 
quickly search inside a document's text. This is now possible using the new 
"Find" toolbar containing a search field, and a next and previous button.

New Easier to Use Print Interface

 

The print dialog has been completely revamped in OpenOffice.org 3.3 to allow 
for a more efficient and usable printing experience.

An integrated preview is available to show the appearance of the document to 
be printed, and all relevant settings can be made f
including number of pages, collation settings, document objects to print or 
hide, page order, print multiple pages, and much more

More Options for Changing Case

With version 3.3, you have more options for changing the case of a
text portion. Apart from toggling uppercase and lowercase, you can now set 
the case to sentence case (first letter capitalized), capitalize every word, or 
invert the current case. 

Redesign of Thesaurus 

Common Search Toolbar 

data indicated that a large portion of OpenOffice.org users want to 
quickly search inside a document's text. This is now possible using the new 
"Find" toolbar containing a search field, and a next and previous button.

New Easier to Use Print Interface 

 

e print dialog has been completely revamped in OpenOffice.org 3.3 to allow 
for a more efficient and usable printing experience. 

An integrated preview is available to show the appearance of the document to 
be printed, and all relevant settings can be made from within this one dialog, 
including number of pages, collation settings, document objects to print or 
hide, page order, print multiple pages, and much more. 

More Options for Changing Case 

With version 3.3, you have more options for changing the case of a
text portion. Apart from toggling uppercase and lowercase, you can now set 
the case to sentence case (first letter capitalized), capitalize every word, or 

data indicated that a large portion of OpenOffice.org users want to 
quickly search inside a document's text. This is now possible using the new 
"Find" toolbar containing a search field, and a next and previous button. 

e print dialog has been completely revamped in OpenOffice.org 3.3 to allow 

An integrated preview is available to show the appearance of the document to 
rom within this one dialog, 

including number of pages, collation settings, document objects to print or 

With version 3.3, you have more options for changing the case of a selected 
text portion. Apart from toggling uppercase and lowercase, you can now set 
the case to sentence case (first letter capitalized), capitalize every word, or 
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The thesaurus dialog has been redesigned for better usability. In addition, a 
new "Synonyms" sub menu in the default context menu allows you to select a 
synonym for the currently selected word right away. 

Resetting Text to the Default Language in Writer 

 

You can now reset the language of text back to the default language using the 
language status bar or the Tools > Language menu. 

 
Text Rendering of Form Controls in Writer 
Form controls in text documents now render their text the same way the 
document itself does, thus making the appearance of controls as part of a text 
flow much more seamless and consistent. 

Changed Defaults for Charts 

Several defaults have changed for OpenOffice.org charts: larger size, larger 
font size, no black borders, better 3D look and more. 

Colored Sheet Tabs in Calc 
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Each sheet in an OpenOffice.org Calc document can now be assigned a color 
for its tab in the Sheet tabs area at the bottom left of the window.

 

Adapt to Marked Selection for Filter Area in Calc

 

In OpenOffice.org Calc, a selection is now shrunk to the act
columns when enabling a filter (AutoFilter, StandardFilter, AdvancedFilter).

Users can select an entire row by clicking on a row header and expect a filter to 
operate on the data below the selected row. If one single row is selected the 
selection is shrunk to the actually used data columns and then expanded over 
all contiguous data rows below. Selecting only a portion of a row behaves 
similar by expanding the selected columns over the data rows. An area 
selected, e.g. more than one entire ro
columns. 

Sort Dialog for DataPilot in Calc

Each sheet in an OpenOffice.org Calc document can now be assigned a color 
for its tab in the Sheet tabs area at the bottom left of the window.

Adapt to Marked Selection for Filter Area in Calc 

 

In OpenOffice.org Calc, a selection is now shrunk to the actually used data 
columns when enabling a filter (AutoFilter, StandardFilter, AdvancedFilter).

Users can select an entire row by clicking on a row header and expect a filter to 
operate on the data below the selected row. If one single row is selected the 

ection is shrunk to the actually used data columns and then expanded over 
all contiguous data rows below. Selecting only a portion of a row behaves 
similar by expanding the selected columns over the data rows. An area 
selected, e.g. more than one entire row, is shrunk to the actual used data 

Sort Dialog for DataPilot in Calc 

Each sheet in an OpenOffice.org Calc document can now be assigned a color 
for its tab in the Sheet tabs area at the bottom left of the window. 

ually used data 
columns when enabling a filter (AutoFilter, StandardFilter, AdvancedFilter). 

Users can select an entire row by clicking on a row header and expect a filter to 
operate on the data below the selected row. If one single row is selected the 

ection is shrunk to the actually used data columns and then expanded over 
all contiguous data rows below. Selecting only a portion of a row behaves 
similar by expanding the selected columns over the data rows. An area 

w, is shrunk to the actual used data 
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The DataPilot (sometimes known as Pivot Table) now supports a convenient 
way of sorting and filtering entries using a special popup window. 

Display Custom Names for DataPilot Fields, Items and Totals in Calc 

DataPilot fields, items and totals can now be assigned custom display names by 
typing into the corresponding cell in the DataPilot table. 

 

Internationalization 

Additional Locale Data 

Arabic (Algeria) [ar-DZ], Bafia (Cameroon) [ksf-CM], Bushi (Mayotte) [buc-YT], 
Campidanese (Sardinia) [sro-IT], Gallurese (Sardinia) [sdn-IT], Gikuyu (Kenya) 
[ki-KE], Latgalian (Latvia) [ltg-LV], Logudorese (Sardinia) [src-IT], Maithili (India) 
[mai-IN], Malagasy Plateau (Madagascar) [plt-MG], Maore (Mayotte) [swb-YT], 
Papiamentu (Netherlands Antilles) [pap-AN], Rusyn (Slovakia) [rue-SK], Rusyn 
(Ukraine) [rue-UA], Sassarese (Sardinia)[sdc-IT], Sorbian, Tahitian (French 
Polynesia) [ty-PF], Upper Sorbian (Germany) [hsb-DE], Yoruba (Nigeria) [yo-NG] 

Developer Features and Extensibility 

Grid Control Enhancements 
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The grid control now accepts additional data types like numbers or images. The 
XGridDatamodel method 
addRow(string headerName, sequence<string> data) 
has changed to 
addRow(string headerName, sequence<any> data) 

You can now control the appearance of a grid control using additional 
parameters for horizontal and vertical alignment, row background colors, line 
colors, and text colors For more information and examples, see the 
OpenOffice.org Wiki pages. 

New MetaData Node for Database 

You can now define a new property in a database driver's xcu file. This is 
enabled by default for MySQL (JDBC) and ADO (including Microsoft Access) 
drivers. The property is defined in the MetaData section. 

  <node oor:name="SupportsColumnDescription" oor:op="replace"> 
      <prop oor:name="Value" oor:type="xs:boolean"> 
          <value>true</value> 
      </prop> 
  </node> 
   
When this property is enabled, the table designer will display the column 
description beside the normal description which is used as help text. 
 
Extending Database Drivers Using Extensions 
Some database drivers do not support special features like altering view 
definitions or adding/dropping table keys. Starting with OpenOffice.org 3.3, the 
corresponding interfaces can be implemented by an extension: 
  com.sun.star.sdb.tools.XViewAccess 
 
  com.sun.star.sdb.tools.XTableRename. 
com.sun.star.sdb.tools.XTableAlteration 
com.sun.star.sdb.tools.XKeyAlteration 
 com.sun.star.sdb.tools.XIndexAlteration 
   

@
Dipl

om
a_

Stud
y_

Roo
m



Practical-8 Explore security features of Operating 
Systems and Tools , try using them and see 
what happens 

Security refers to providing a protection system to computer system 
resources such as CPU, memory, disk, software programs and most 
importantly data/information stored in the computer system. If a 
computer program is run by an unauthorized user, then he/she may 
cause severe damage to computer or data stored in it. So a computer 
system must be protected against unauthorized access, malicious 
access to system memory, viruses, worms etc. We're going to discuss 
following topics in this chapter. 

 Authentication 
 One Time passwords 
 Program Threats 
 System Threats 
 Computer Security Classifications 

Authentication 
Authentication refers to identifying each user of the system and 
associating the executing programs with those users. It is the 
responsibility of the Operating System to create a protection system 
which ensures that a user who is running a particular program is 
authentic. Operating Systems generally identifies/authenticates users 
using following three ways − 

 Username / Password − User need to enter a registered 
username and password with Operating system to login into the 
system. 
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 User card/key − User need to punch card in card slot, or enter 
key generated by key generator in option provided by operating 
system to login into the system. 

 User attribute - fingerprint/ eye retina pattern/ signature − User 
need to pass his/her attribute via designated input device used 
by operating system to login into the system. 

One Time passwords 
One-time passwords provide additional security along with normal 
authentication. In One-Time Password system, a unique password is 
required every time user tries to login into the system. Once a one-
time password is used, then it cannot be used again. One-time 
password are implemented in various ways. 

 Random numbers − Users are provided cards having numbers 
printed along with corresponding alphabets. System asks for 
numbers corresponding to few alphabets randomly chosen. 

 Secret key − User are provided a hardware device which can 
create a secret id mapped with user id. System asks for such 
secret id which is to be generated every time prior to login. 

 Network password − Some commercial applications send one-
time passwords to user on registered mobile/ email which is 
required to be entered prior to login. 

Program Threats 
Operating system's processes and kernel do the designated task as 
instructed. If a user program made these process do malicious tasks, 
then it is known as Program Threats. One of the common example of 
program threat is a program installed in a computer which can store 
and send user credentials via network to some hacker. Following is the 
list of some well-known program threats. 
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 Trojan Horse − Such program traps user login credenƟals and 
stores them to send to malicious user who can later on login to 
computer and can access system resources. 

 Trap Door − If a program which is designed to work as required, 
have a security hole in its code and perform illegal action without 
knowledge of user then it is called to have a trap door. 

 Logic Bomb − Logic bomb is a situaƟon when a program 
misbehaves only when certain conditions met otherwise it works 
as a genuine program. It is harder to detect. 

 Virus − Virus as name suggest can replicate themselves on 
computer system. They are highly dangerous and can 
modify/delete user files, crash systems. A virus is generatlly a 
small code embedded in a program. As user accesses the 
program, the virus starts getting embedded in other files/ 
programs and can make system unusable for user 

System Threats 
System threats refers to misuse of system services and network 
connections to put user in trouble. System threats can be used to 
launch program threats on a complete network called as program 
attack. System threats creates such an environment that operating 
system resources/ user files are misused. Following is the list of some 
well-known system threats. 

 Worm − Worm is a process which can choked down a system 
performance by using system resources to extreme levels. A 
Worm process generates its multiple copies where each copy 
uses system resources, prevents all other processes to get 
required resources. Worms processes can even shut down an 
entire network. 
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 Port Scanning − Port scanning is a mechanism or means by which 
a hacker can detects system vulnerabilities to make an attack on 
the system. 

 Denial of Service − Denial of service aƩacks normally prevents 
user to make legitimate use of the system. For example, a user 
may not be able to use internet if denial of service attacks 
browser's content settings. 
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